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Abstract

The Borobudur Temple tourism is targeted by the Indonesian government as one of the “Ten New Bali” in 2025.
Currently, the service quality in Borobudur Temple is still perceived as low by tourists, which is shown in many bad
reviews on social media, reflecting the lack of visitor satisfaction in Borobudur Temple, especially during the
pandemic Covid-19 and the new normal era. Therefore, it is crucial to explore the factors that affect visitor's
satisfaction in order to improve the tourism service quality in Borobudur Temple during the Covid-19 pandemic and
the new normal era. Four pillars of tourism namely attraction, accessibility, amenity, and ancillary are analyzed using
a Fuzzy Set Qualitative Comparative Analysis (fSQCA) approach to formulating the best configurations model to
improve the visitor’s satisfaction. This research found the configurational model that consists of two factors
combinations that produces a high visitor satisfaction and three factors combinations that result in low visitor
satisfaction. Further analyses are made based on those configurational models to propose service quality
improvements in Borobudur Temple.
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1. Introduction

Tourism sector in Indonesia plays a high role in contributing to the nation’s gross domestic product and the nation’s
foreign exchange (Kemenparekraf 2021) while Bali still become the main tourism destination icon in Indonesia,
proven by almost half of the number tourism arrival is to Bali (Ollivaud and Haxton 2019). This shows how popular
Bali is but on the other hand also indicates the other destinations are less popular despite having many great potencies.
Because of that, in 2017 the government announced the new development of the priority tourism destination as the”
Ten New Balis” to boost the other destinations to be the new icon of Indonesian tourism destination. Borobudur
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Temple is the one of them. This temple is located in Magelang Regency, Central Java Province, Indonesia. Borobudur
Temple have grown and have attracted many tourists in the past few years, making this destination a great potential
destination to be developed. The development itself as the priority tourism destination is based on attraction,
accessibility, amenity, and ancillary as four pillars of tourism development (Kemenparekraf 2022). These four pillars
of tourism development have been integrated in the development scheme to become a continuity plan. However, the
development is hampered because of Covid-19 pandemic. Luckily, because of vaccination and new normal policy,
some tourism destination including Borobudur Temple have opened by still implementing the health protocol.

However, the development and the service quality in Borobudur Temple are still considered bad in implementation
by visitors, both before and during new normal era. This is shown in many bad reviews at Google Review and
Tripadvisor site as the result of the preliminary that conducted by listing the bad reviews with low scores. Two hundred
and thirty-two reviews before new normal era are listed from Tripadvisor with 1 until 2 review score and from Google
Review with 1 review score with the range from 2018 to 2020. While 137 reviews during new normal era are listed
from Google Review with 1 revies score with the range from 2020 to 2022. Total review recapitulations can be seen
in Figure 1.

The price during pandemic is same with
before pandemic but visitors can't go up to
the temple without clear reason

M Bad exit scheme

M Overpriced
M Terrible animal attraction
14.91% [ Discriminative price for foreigners

[ sellers are too pushy in selling
[(Lack of hospitality from the staff
M Untidy and illegal parking

[ Lack of toilet and bad sanitation
M Long distance to the temple
[Cother

Figure 1. Bad Reviews of Borobudur

All those bad reviews indicate the lack of visitor’s satisfaction in Borobudur Temple. Besides, many of the comments
from the visitors contains several different critique aspects that linked to the four pillars of tourism development. This
shows that Borobudur Temple’s development as the priority tourism destination is have not considered satisfied yet
by the visitors. All reviews also show that each visitor has their own critiques to the Borobudur Temple’s development
which make the visitor’s preferences are complex, diverse, and unique about the development factors. Therefore, it is
very important to improve these four pillars of tourism development to improve the service quality in Borobudur
Temple by finding the best combination of all factors and find which factors that can be improved more. This can be
solved with a method named Fuzzy Set Qualitative Comparative Analysis (fSQCA). The fSQCA method focuses on
cases where it allows researcher to highlight the complexity, diversity, and uniqueness in every case where still gives
a generalization pattern in its analyses (Verweij and Trell 2019). This research aims to find the best configuration
model of attraction, accessibility, amenity, and ancillary to improve the visitor’s satisfaction in Borobudur Temple.

2. Literature Review

2.1 Tourism Development Pillars and Visitor’s Satisfaction

The development of Borobudur Temple as the priority tourism destination is based on attraction, accessibility,
amenity, and ancillary. Attraction is described as everything in the tourism object that can attract tourist to visit the
destination (Kartika et al 2018). Accessibility is described as the supporting infrastructure to facilitate the tourist to
visit the destination (Ismail and Rohman 2019). Those infrastructure could be roads, bridges, stations, bus stations, or
airports. Amenity itself is described as the facilities to facilitate the tourism activity and provide comfort to the visitors
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(Kagungan et al 2021). Lastly ancillary is described as additional service facilities that support tourist’s activities in
the destination. These facilities might link indirectly to the tourism activity, but these facilities are needed by some
visitors (Buhalis and Amaranggana 2013). Visitor’s satisfaction is described as the responds form visitors about the
evaluation of the inconformity about the visitor’s expectation or other performance indicator about the destination to
the actual performance perceived from the destination (Ismail and Rohman 2019). Visitor’s satisfaction could be seen
as the quality measurement from the visitor’s experience (Moore et al 2013).

The four pillars of tourism development highly impact the visitor’s satisfaction. As shown by Ismail and Rohman
(2019) on their research at Gili Ketapang Beach, East Java Province, Indonesia; attraction and ancillary aspects give
significant positive impact to visitor’s satisfaction. Accessibility aspect also have a significant positive impact towards
visitor’s satisfaction as explained by Culi¢ et al (2021) on their research at tourism destination in Serbia. Another
research by Hermawan et al (2019) at Nglanggeran ancient Volcano in Yogyakarta Province, Indonesia proves that
amenity also give a significant positive impact towards visitor’s satisfaction. For research in Borobudur Temple, there
is research from Rahmiati and Winata (2020) that studied the effect of attraction, accessibility, and amenity towards
visitor’s satisfaction in Borobudur Temple and found that all three factors give positive effect to the visitor’s
satisfaction.

2.2 Fuzzy Set Qualitative Comparative Analysis (fsQCA)

Fuzzy Set Qualitative Comparative Analysis (fsSQCA) is the newest type of Qualitative Comparative Analysis (QCA)
method. QCA itself is a hybrid method that combine the benefits from qualitative analysis with its case oriented and
from quantitative analysis with its variable oriented (Yong and Park 2017). QCA is aimed to identify condition
variables that must appear or sufficient to appear in resulting certain outcomes (Gerrits and Pagliarin 2021). Although
QCA mainly focuses on cases, QCA can still give a generalization pattern for all cases with Boolean algebra
mechanism (1 or 0). There are three types of QCA namely Crisp set QCA (csQCA) using only conventional Boolean
algebra, multi value QCA (mvQCA) using multi value, and fuzzy set QCA (fsQCA) using fuzzy value (Y afiez-Araque
etal 2021). Asthe newest type of QCA, fSQCA remains superior to other two predecessor because fSQCA can analyze
the condition variables with more diverse range by the fuzzy value before generalizing it into Boolean number. This
is because on the actual case, there are some condition variables that cannot be determined clearly as 1 or 0.

The fSQCA method has three principles namely conjunction, equifinality, and asymmetric (Baquero et al 2019).
Conjunction principle means that the outcome does not comes from per set results but from the combined condition
in the configuration. Equifinality principle means that the same outcomes can be obtained from more than one
configuration. While asymmetric principle means that the certain causal condition obtained to explain certain outcome
cannot be concluded absolutely that the negation of this causal condition also results the negation of that outcome.
Based on those principles, fsSQCA can explain a “sufficient condition” (where a condition in the configuration is quite
capable explaining the outcome), “necessary condition” (where a condition is a must to present in the configuration
for certain outcome occurs), and “insufficient but necessary condition” (where a condition must present but not enough
capable for explaining the outcome without other condition) (Pappas and Woodside 2021).

3. Methods

This research uses fSQCA to find the best configuration of attraction, accessibility, amenity, and ancillary in resulting
the outcome which is in this case is visitor’s satisfaction. This research is not only analyzing high visitor’s satisfaction
but also analyzing low visitor’s satisfaction to make the results analyses deeper and more comprehensive. The research
conceptual model is shown in Figure 2.

Attraction
Accessibility
Amenity
Ancillary

Visitor's Satisfaction ]

Figure 2. Conceptual Model

There are several steps in fsSQCA. The first step is data aggregation and threshold determination. This step is done by
finding the average of the indicators in each variable and each respondent from the collected data so there is only one
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value for each variable in every case or respondent (Pappas and Woodside 2021). This averaged data is called
aggregate data. Next is determining the thresholds that become an indicator for changing the aggregate data to fuzzy
value. This threshold is divided to upper breakpoint, middle breakpoint, and lower breakpoint.

The second step is fuzzy calibration. Fuzzy calibration is a step to change the aggregate data to fuzzy value using the
threshold that have been determined before. Those thresholds will determine the fuzzy membership function of the
case where is categorized full membership (labeled as “1”), non-membership (labeled as “0), or crossover
membership (labeled as “0,5”) (Pappas and Woodside 2021).

The next step of fSQCA is constructing the truth table. Truth table is a matrix table that contains all possible causal
condition combinations. The combinations are constructed by all Boolean number of each causal condition that are
made from the final fuzzy calibration results. For the causal conditions, the fuzzy set membership above 0,5 will be
given symbol “1”, means “presence” and is associated as “high” in terminology. While the fuzzy set membership
below 0,5 will be given symbol “0” means “absence” and is associated as “low”. The determination of “presence” and
“absence” for the outcomes uses the raw consistency that shows the empirical level of whether the combination can
support the conceptual model (Fiss 2011). The combination with the raw consistency above 0,8 will be considered
“presence” and labeled as “1”” while below 0,8 is “absence” and is given “0” as the label (Fiss 2011). Furthermore, it
is also conducted a configuration elimination to focus the analyses into the larger number of cases. The eliminated
configurations are the configurations which have the number of cases below 2 since the data used in this research are
below 150 data (Fiss 2011).

The last step in fSQCA is finding the solution configuration using the Boolean minimization process. In this step, all
condition that result the presence outputs will be minimized to get the best optimal configuration solution. It is also
conducted a necessary condition analysis to find what condition that must present to create certain outputs.

4. Data Collection

The respondent’s data are collected through online questionnaire with the targeted respondents are those who ever
visited Borobudur Temple during Covid-19 pandemic (year 2020 to 2022). Five-point Likert scale is used in this
research with “1” refers to “very disagree” while “5” refers to “very agree”. Each attribute and indicators can be seen
in Table 1.

Table 1. Questionnaire Attributes and Indicators

Attribute Code Indicator Reference
ATT1 | Attraction Strength
ATT2 | Tourism Activity on Location Pinangias et al.
Attraction ATT3 | Supporting Attraction Diversity (2021), Yusendra
(ATT) ATT4 | Environmental Cleanness and Paramitasari
ATTS | Condition of Tourism Object (2018)
ATT6 | Attractive Events
ACCI1 | Infrastructure Interconnection Pinangias et al.
ACC2 | Roads Conditions to the Location (2021), Yusendra

Accessibility ["A 3 and Paramitasari

Availability of Various Modes of Transportation

(ACC) ACC4 | Smooth Traffic Flows (2018),
Kemenparekraf
ACCS5 | Travel Time from the Nearest Airport, Terminal, and Station (2022)
AMNI | Service and hospitality Pinangias et al.
AMN? | Professional Tourism Workers (2021), Yusendra
Amenities | AMN3 | Covid-19 health protocol service and Paramitasari
(AMN) AMN4 | Hotels and Lodgings (2018),
AMNS5 | Hygiene and Permitted Restaurant Kemenparekraf
AMNG6 | Souvenir Shops (2022)
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Table 1. Questionnaire Attributes and Indicators (Cont.)

Attribute Code Indicator Reference
ANCI1 | Telecommunication network Pinangias et al.
. ANC2 | Waste Management (2021), Yusendra
Ancillary ANC3 | Water Supply Services and Paramitasari
(ANC) ANC4 | Accessible Tourist Information Centre (2018),
Kemenparekraf
ANCS | Exciting Tour Packages (2022)

SAT1 | Satisfaction with the Travel Experience

Satisfaction X . Rasoolimanesh et
(SAT) SAT2 | Feeling about the Travel Experience al. (2021)

SAT3 | Pleasant Experience in the Destination

Before distributing the questionnaire, two-way translation process is conducted by translating the original
questionnaire items that are written in foreign language to avoid a shift in meaning (Lee et al. 2019). Pilot study is
also conducted to evaluate the questionnaire quantitatively by asking some respondents to fill it and answer some
question about the questionnaire’s quality (Hartono 2010). The minimum sample needed for this research with 4
predictors is 85 respondents based on the A-priori power analysis using G*Power software. Total 137 respondents are
obtained in this research, 30 Indonesian respondents and 7 foreign respondents. Validity and reliability test are
conducted with 137 data. It is found that the collected data is valid and reliable.

5. Results and Discussion

5.1 Data Aggregation and Threshold Determination

The data aggregation and threshold determination become the first step in fSQCA. This research used 80™ percentile
as upper breakpoint, 50" percentile as middle breakpoint, and 20™ percentile as lower breakpoint for the thresholds
because the collected data are skewed to the right (Pappas et al. 2017). Data aggregation is shown on Table 2 while
the thresholds is on Table 3.

Table 2. Data Aggregation Table 3. Thresholds

Respondent ATT | ACC | AMN | ANC SAT Threshold ATT | ACC | AMN | ANC | SAT
Respondent 1 4,67 3,80 3,17 3,00 4,00 Upper Breakpoint 483 | 480 | 4,67 | 480 | 5,00
Respondent 2 4,17 4,00 3,50 3,00 4,00 Middle Breakpoint | 4,33 | 4,20 | 4,17 | 4,00 | 4,67
Respondent 3 4,50 3,80 3,00 2,20 4,00 Lower Breakpoint 3,67 | 3,60 | 3,67 | 3,52 | 4,00
Respondent 4 3,67 3,60 3,17 3,60 3,00
Respondent 5 3,67 3,80 3,83 3,00 4,67
Respondent 6 4,00 3,40 3,67 3,40 4,00
Respondent 7 3,83 4,20 4,17 3,40 433
Respondent 136 | 3,50 3,80 3,33 3,20 4,00
Respondent 137 | 3,67 3,40 4,00 3,60 3,67

5.2 Fuzzy Calibration

The next step in fSQCA is fuzzy calibration by changing the aggregate data into fuzzy value. This step is done by
choosing “Variable > Compute” in fSQCA software version 3.1 and then input the desired causal condition with its
thresholds. All causal conditions name also changed to differentiate the new fuzzy set with the older aggregate data.
For example, “fATT” means fuzzy set for ATT. The fuzzy calibration result is shown in Table 4. All aggregate data
will be changed to fuzzy value and after that to Boolean number (either 0 or 1). The intermediate set become a
determination for changing the fuzzy set into Boolean number because those fuzzy set more than 0,5 will be changed
to 1 while below 0,5 will be changed to 0. However, cases with the exact value on 0,5 is difficult to be analyzed. It
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will be excluded from the analysis because of the same value of the intermediate set as a middle breakpoint. This case
can be solved by adding 0,001 to all causal conditions that below the full membership with the value of 1 (Fiss 2011).
The final fuzzy calibration result after being added with 0,001 is shown in Table 5.

Table 4. Fuzzy Calibration Result Table 5. Final Fuzzy Calibration Result

Case | fATT | fACC | fAMN | fANC | fSAT Case | fATT | fACC | fAMN | fANC | fSAT
Resl 0,88 | 0,12 0 0 0,05 Resl 0,881 | 0,121 | 0,001 | 0,001 | 0,051
Res?2 0,33 | 0,27 | 0,02 0 0,05 Res2 0,331 | 0,271 | 0,021 | 0,001 | 0,051
Res3 0,73 | 0,12 0 0 0,05 Res3 0,731 | 0,121 | 0,001 | 0,001 | 0,051
Res4 0,05 | 0,05 0 0,08 0 Res4 0,051 | 0,051 | 0,001 | 0,081 | 0,001
Res5 0,05 | 0,12 | 0,12 0 0,5 Res5 0,051 | 0,121 | 0,121 | 0,001 | 0,501
Res6 0,18 | 0,02 | 0,05 0,02 | 0,05 Res6 0,181 | 0,021 | 0,051 | 0,021 | 0,051
Res7 0,09 0,5 0,5 0,02 | 0,18 Res7 0,091 | 0,501 | 0,501 | 0,021 | 0,181
Resl136 | 0,02 | 0,12 | 0,01 0,01 | 0,05 Resl136 | 0,021 | 0,121 | 0,011 | 0,011 | 0,051
Resl137 ] 0,05 | 0,02 | 027 | 0,08 | 0,01 Res137 | 0,051 | 0,021 | 0,271 | 0,081 | 0,011

5.3 Truth Table Construction

In the fsSQCA software, this action can be done by choosing “Analyze > Truth Table Algorithm” and then selecting
the desired outcomes and causal conditions. In this research, the outcomes that will be analyzed are high satisfaction
that labeled as “fSAT” and low satisfaction as “~fSAT”. These steps are done in fSQCA software by choosing “Edit
> Delete and Code” on the “Edit Truth Table” dialog box. The truth table for high satisfaction is shown on Table 6
while for low satisfaction is on Table 7.

Table 6. Truth Table for High Satisfaction (fSAT) Table 7. Truth Table for Low Satisfaction (~fSAT)
FATT | fACC | fAMN | fANC | Case | fsAT | R&W FATT | fACC | fAMN | fANC | Case | ~fSAT | .R&W

Consist. Consist.
1 1 1 1 44 1 0,882973 0 0 0 0 37 1 0,875361
1 1 1 0 3 1 0,836868 1 0 0 0 2 1 0,85055
1 0 1 1 9 1 0,835084 0 0 0 1 7 1 0,839655
1 1 0 1 3 0 0,790026 0 1 0 0 5 1 0,812364
0 1 1 1 8 0 0,77858 1 0 0 1 5 0 0,795996
0 0 1 1 2 0 0,770412 0 0 1 0 2 0 0,756066
0 1 1 0 3 0 0,740661 0 1 1 0 3 0 0,737806
1 0 0 1 5 0 0,707953 0 1 0 1 2 0 0,732762
1 1 0 0 4 0 0,701789 1 1 0 0 4 0 0,69998
0 0 1 0 2 0 0,687867 0 0 1 1 2 0 0,681442
0 1 0 1 2 0 0,680039 1 1 1 0 3 0 0,630021
1 0 0 0 2 0 0,598571 1 1 0 1 3 0 0,609457
0 0 0 1 7 0 0,565716 0 1 1 1 8 0 0,605358
0 1 0 0 5 0 0,536644 1 0 1 1 9 0 0,59657
0 0 0 0 37 0 0,283362 1 1 1 1 44 0 0,276521

5.4 Solution Configuration

Solution configurations are the best configuration that can produce certain outcomes. In fSQCA 3.1, solution
configuration can be calculated by selecting “Standard Analyses” in the “Edit Truth Table” dialog box. For high
satisfaction, this research finds two solution configurations. The solution configuration results for high satisfaction
can be seen in Table 8.
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Table 8. Solution Configurations for High Satisfaction

Raw Unique
Coverage | Coverage

fATT*fACC*fAMN | 0,579386 0,0413672 | 0,880819
fATT*fAMN*fANC | 0,622778 0,0847593 | 0,87413

Solution Coverage: 0,664145
Solution Consistency: 0,872831

Configurations Consistency

The first solution configuration for high satisfaction is fATT*fACC*fAMN that can be interpreted as the visitors could
have high level of satisfaction due to high level of attraction, accessibility, and amenity. This is in accordance with
the research from Rahmiati and Winata (2020) which found attraction, accessibility, and amenity have a positive
influence on the occurrence of visitor’s satisfaction.

The second solution configuration for high satisfaction is fATT*fAMN*fANC that can be interpreted as high level of
attraction, amenity, and ancillary are contributing to the occurrence on high satisfaction. In this configuration, both
high attraction and high ancillary show positive impact on high satisfaction, in line with the previous research by
Ismail and Rohman (2019) who found attraction and ancillary significantly influence visitor’s satisfaction. This
configuration also being strengthen with the presence of high amenity that also contributing to high visitor’s
satisfaction. This is in accordance with the research from Hermawan et al (2019), found that amenity corelate
positively with the level of visitor’s satisfaction. Next is the solution configuration results for low satisfaction that can
be seen in Table 9.

Table 9. Solution Configurations for Low Satisfaction

Raw Unique
Coverage Coverage

~fACC*~fAMN*~fANC | 0,642967 0,0499536 | 0,869304
~fATT*~fAMN*~fANC | 0,641336 0,0483326 | 0,86694
~fATT*~fACC*~fAMN | 0,627632 0,0346287 | 0,867068

Configurations Consistency

Solution Coverage: 0,725918
Solution Consistency: 0,855661

The first solution configuration for low satisfaction is ~fACC*~fAMN*~fANC that can be interpreted as low
accessibility, low amenity, and low ancillary simultaneously accommodate low visitor’s satisfaction. Accessibility
plays a great role in the configuration. As mentioned by Culi¢ et al (2021), accessibility gives a positive impact to
visitor’s satisfaction, implied that if it is on the low level, the visitor’s will also on the low level. This configuration
also mentioned low amenity that resulted on low visitor’s satisfaction. This is opposed to Culi¢ et al (2021) who
mentioned that amenity didn’t have a significance effect to satisfaction where this research found that amenity is one
of the important conditions to produce satisfaction. However, this research is in accordance with Ismail and Rohman
(2019) who found ancillary significantly affects visitor’s satisfaction.

The second solution configuration for low satisfaction is ~FATT*~fAMN*~fANC that can be interpreted as the low
visitor’s satisfaction can occur because of the combination of low attraction, low amenity, and low ancillary.
Constantin et al (2022) explain that attraction and amenity have a significant impact to visitor’s satisfaction. Low
attraction and accessibility factors will cause low visitor’s satisfaction. However, this research is not in line with
Watanabe et al (2018) that explains ancillary has a negative impact to visitor’s satisfaction, means high level of
ancillary will results in low level of visitor’s satisfaction and vice versa. Meanwhile this research find that ancillary
has a positive impact to visitor’s satisfaction, low ancillary contributing to low visitor’s satisfaction

The third solution configuration for low satisfaction is ~FATT*~fACC*~fAMN that can be interpreted as the visitors
could feel a low satisfaction because of the low attraction, low accessibility, and low amenity of the destination. Once
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again this is aligned with the research from Rahmiati and Winata (2020) which explains all those three factors have
positive influence on satisfaction. This means that low attraction, accessibility, and amenity will also contributing on
low visitor’s satisfaction.

5.5 Necessary Condition Analysis

A causal condition is categorized as necessary condition if its consistency value is above 0,90 (Dul 2016). In fSQCA
3.1, this action is done by click “Analyze > Necessary Condition” and select the desired outcomes and all causal
conditions. Necessary condition for high satisfaction is shown in Table 10 while for low satisfaction is on the Table
11. Based on the necessary condition analysis, there are no necessary condition in both high and low satisfaction
because there are no conditions with the consistency more than 0,90.

Table 10. Necessary Condition Analysis for High Table 11. Necessary Condition Analysis for Low
Satisfaction Satisfaction

Causal Condition | Consistency | Coverage Causal Condition | Consistency | Coverage
fATT 0,774361 0,767699 fATT 0,353285 0,343791
~fATT 0,338097 0,347516 ~fATT 0,761284 0,768075
fACC 0,743540 0,766945 fACC 0,343118 0,347964
~fACC 0,368616 0,363744 ~fACC 0,770126 0,745943
fAMN 0,775808 0,806608 fAMN 0,298263 0,304389
~fAMN 0,330952 0,324539 ~fAMN 0,810500 0,780151
fANC 0,773493 0,792875 fANC 0,336958 0,339037
~fANC 0,355193 0,353069 ~fANC 0,794144 0,774848

5.6 Best Solution Configuration

Based on the calculation before, this research can tabulate the best solution configuration for both high and low
visitor’s satisfaction. The tabulation is shown in Table 12. Black circles indicates that the condition is presence (high),
the cross sign (X) indicates that the condition is absence (low), and the blank space indicates the don’t care condition.

Table 12. Best Solution Configuration

Solution Configuration
Condition High Satisfaction Low Satisfaction
1 2 1 2 3
Attraction [ ) [ ] X a
Accessibility @ X X
Amenity o o X X X
Ancillary [ J X X

The solution configurations show the conjunction principle, means that certain outcome is occurred because of the
combination of the conditions. But as can be seen in Table 12, it is not necessarily needing all high or all low of the
four conditions in resulting certain outcomes. There are some configurations with blank space (don’t care), showing
whether that condition is high or low, the outcome is still the same. However, this do not negate the conjunction
principle since the outcomes are presence due to the combination of four conditions whether those conditions are high,
low, or don’t care. This research obtained two configurations for high satisfaction and three configurations for low
satisfaction. These configurations prove the equifinality principle that certain outcomes, high and low satisfaction in
this case, can be obtained from more than one configuration.

This research also proves the asymmetric principle in QCA that can be seen in the truth table. For example, the first

configuration in the truth table of high satisfaction, fATT*fACC*fAMN*fANC or high attraction, high accessibility,
high amenity, and high ancillary. It cannot be concluded absolutely that if certain condition for example high ancillary
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(fANC) is low, the outcome will show low satisfaction (the negation of high satisfaction). This is proven by
fATT*fACC*fAMN*~fANC or high attraction, high accessibility, high amenity, and high ancillary as the second
configuration in the truth table of high satisfaction. The second configuration shows that even the ancillary is low
(~fANC), the configuration still produces high satisfaction.

On the practical advice, of course the Borobudur Temple’s management must enhance all four pillars of tourism
development. However, the management can pay more attention to enhance the amenity aspects because amenity is
presence on all solution configurations both high and low level of satisfaction, indicating that this aspect is very
important to presence. Although it is not a necessary condition, amenity has the highest coverage and consistency
based on the necessary condition analysis. For high satisfaction, the condition is high amenity (fAMN) with 0,775808
in consistency and 0,806608 in coverage while for low satisfaction, the condition is low amenity (~fAMN) with
0,810500 in consistency and 0,780151 in coverage.

To achieve the high level of visitor’s satisfaction, the management also can focus on enhancing other aspects based
on the high satisfaction solution configuration especially first solution configuration (FATT*fACC*fAMN) because
this configuration has higher consistency with value of 0,880819 than the second solution configuration
(FATT*fAMN*fANC) with 0,86694 in consistency. Furthermore, to avoid the occurrence of low visitor’s satisfaction,
the management must highly maintain all four pillars of tourism in the implementation and ensure that no aspects in
those four pillars can construct even one of the three solution configurations of low satisfaction.

6. Conclusion

This research aims to find the best configuration to improve the visitor’s satisfaction and found two configurations
that produces high visitor’s satisfaction and three configuration that produces low visitor’s satisfaction. Amenity
become the aspect that could be given more consideration due to its presence on all solution configuration and the
high value of consistency and coverage. This research also finds some configuration that must be avoided so the low
level of visitor’s satisfaction doesn’t occur. However, in the future this research must be compared to other research
which conducted when the pandemic era is over to see how far the relevance of this research when the condition is
back to normal.
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